Worldwide Technical Support and Product Information

ni.com

National Instruments Corporate Headquarters
11500 North Mopac Expressway Austin, Texas 78759-3504 USA Tel: 512 683 0100

Worldwide Offices
Australia 1800 300 800, Austria 43 0 662 45 79 90 0, Belgium 32 0 2 757 00 20, Brazil 55 11 3262 3599, 
Canada (Calgary) 403 274 9391, Canada (Ottawa) 613 233 5949, Canada (Québec) 450 510 3055, 
Canada (Toronto) 905 785 0085, Canada (Vancouver) 514 685 7530, China 86 21 6555 7838, 
Czech Republic 420 224 235 774, Denmark 45 45 76 26 00, Finland 385 0 9 725 725 11, 
France 33 0 1 48 14 24 24, Germany 49 0 89 741 31 30, Greece 30 2 10 42 96 427, India 91 80 5119000, 
Israel 972 0 3 6393737, Italy 39 02 413091, Japan 81 3 5472 2970, Korea 82 10 857531 3400, 
Malaysia 603 9131 0918, Mexico 001 800 010 0793, Netherlands 31 0 348 433 466, 
New Zealand 0800 553 322, Norway 47 0 66 90 76 60, Poland 48 22 3390150, Portugal 351 210 311 210, 
Russia 7 095 783 68 51, Singapore 65 6226 5886, Slovenia 386 3 425 4200, South Africa 27 0 11 805 8197, 
Spain 34 91 640 0085, Sweden 46 0 8 587 895 00, Switzerland 41 56 200 51 51, Taiwan 886 2 2528 7227, 
Thailand 662 992 7519, United Kingdom 44 0 1635 523545

For further support information, refer to the Technical Support and Professional Services appendix. To comment on the documentation, send email to techpubs@ni.com.

© 2000–2004 National Instruments Corporation. All rights reserved.
Important Information

Warranty
The media on which you receive National Instruments software are warranted not to fail to execute programming instructions, due to defects in materials and workmanship, for a period of 90 days from date of shipment, as evidenced by receipts or other documentation. National Instruments will, at its option, repair or replace software media that do not execute programming instructions if National Instruments receives notice of such defects during the warranty period. National Instruments does not warrant that the operation of the software shall be uninterrupted or error free.

A Return Material Authorization (RMA) number must be obtained from the factory and clearly marked on the outside of the package before any equipment will be accepted for warranty work. National Instruments will pay the shipping costs of returning to the owner parts which are covered by warranty.

National Instruments believes that the information in this document is accurate. The document has been carefully reviewed for technical accuracy. In the event that technical or typographical errors exist, National Instruments reserves the right to make changes to subsequent editions of this document without prior notice to holders of this edition. The reader should consult National Instruments if errors are suspected. In no event shall National Instruments be liable for any damages arising out of or related to this document or the information contained in it.

EXCEPT AS SPECIFIED HEREIN, NATIONAL INSTRUMENTS MAKES NO WARRANTIES, EXPRESS OR IMPLIED, AND SPECIFICALLY DISCLAIMS ANY WARRANTY OF MERCHANTABILITY OR FITNESS FOR A PARTICULAR PURPOSE. CUSTOMER’S RIGHT TO RECOVER DAMAGES CAUSED BY FAULT OR NEGLIGENCE ON THE PART OF NATIONAL INSTRUMENTS SHALL BE LIMITED TO THE AMOUNT THEREFORE PAID BY THE CUSTOMER. NATIONAL INSTRUMENTS WILL NOT BE LIABLE FOR DAMAGES RESULTING FROM LOSS OF DATA, PROFITS, USE OF PRODUCTS, OR INCIDENTAL OR CONSEQUENTIAL DAMAGES, EVEN IF ADVISED OF THE POSSIBILITY THEREOF. THIS LIMITATION OF THE LIABILITY OF NATIONAL INSTRUMENTS WILL APPLY REGARDLESS OF THE FORM OF ACTION, WHETHER IN CONTRACT OR TORT, INCLUDING NEGLIGENCE. ANY ACTION AGAINST NATIONAL INSTRUMENTS MUST BE BROUGHT WITHIN ONE YEAR AFTER THE CAUSE OF ACTION ACCRUES. NATIONAL INSTRUMENTS SHALL NOT BE LIABLE FOR ANY DELAY IN PERFORMANCE DUE TO CAUSES BEYOND ITS REASONABLE CONTROL. THE WARRANTY PROVIDED HEREIN DOES NOT COVER DAMAGES, DEFECTS, MALFUNCTIONS, OR SERVICE FAILURES CAUSED BY OWNER’S FAILURE TO FOLLOW THE NATIONAL INSTRUMENTS INSTALLATION, OPERATION, OR MAINTENANCE INSTRUCTIONS; OWNER’S MODIFICATION OF THE PRODUCT; OWNER’S ABUSE, MISUSE, OR NEGREGENT ACTS; AND POWER FAILURE OR SURGES, FIRE, FLOOD, ACCIDENT, ACTIONS OF THIRD PARTIES, OR OTHER EVENTS OUTSIDE REASONABLE CONTROL.

Copyrght
Under the copyright laws, this publication may not be reproduced or transmitted in any form, electronic or mechanical, including photocopying, recording, storing in an information retrieval system, or translating, in whole or in part, without the prior written consent of National Instruments Corporation.

Trademarks
AutoCode™, DocumentIt™, MATRIXx™, National Instruments™, NI™, ni.com™, SystemBuild™, and Xmath™ are trademarks of National Instruments Corporation.

Product and company names mentioned herein are trademarks or trade names of their respective companies.

Patents
For patents covering National Instruments products, refer to the appropriate location: Help>Patents in your software, the patents.txt file on your CD, or ni.com/patents.

WARNING REGARDING USE OF NATIONAL INSTRUMENTS PRODUCTS
(1) NATIONAL INSTRUMENTS PRODUCTS ARE NOT DESIGNED WITH COMPONENTS AND TESTING FOR A LEVEL OF RELIABILITY SUITABLE FOR USE IN OR IN CONNECTION WITH SURGICAL IMPLANTS OR AS CRITICAL COMPONENTS IN ANY LIFE SUPPORT SYSTEMS WHOSE FAILURE TO PERFORM CAN REASONABLY BE EXPECTED TO CAUSE SIGNIFICANT INJURY TO A HUMAN.

(2) IN ANY APPLICATION, INCLUDING THE ABOVE, RELIABILITY OF OPERATION OF THE SOFTWARE PRODUCTS CAN BE IMPAIRED BY ADVERSE FACTORS, INCLUDING BUT NOT LIMITED TO FLUCTUATIONS IN ELECTRICAL POWER SUPPLY, COMPUTER HARDWARE MALFUNCTIONS, COMPUTER OPERATING SYSTEM SOFTWARE, FITNESS, FITNESS OF COMPILERS AND DEVELOPMENT SOFTWARE USED TO DEVELOP AN APPLICATION, INSTALLATION ERRORS, SOFTWARE AND HARDWARE COMPATIBILITY PROBLEMS, MALFUNCTIONS OR FAILURES OF ELECTRONIC MONITORING OR CONTROL DEVICES, TRANSIENT FAILURES OF ELECTRONIC SYSTEMS (HARDWARE AND/OR SOFTWARE), UNANTICIPATED USES OR MISUSES, OR ERRORS ON THE PART OF THE USER OR APPLICATION DESIGNER (ADVERSE FACTORS SUCH AS THESE ARE HEREAFTER COLLECTIVELY TERMED “SYSTEM FAILURES”). ANY APPLICATION WHERE A SYSTEM FAILURE WOULD CREATE A RISK OF HARM TO PROPERTY OR PERSONS (INCLUDING THE RISK OF BODILY INJURY AND DEATH) SHOULD NOT BE RELIANT SOLELY UPON ONE FORM OF ELECTRONIC SYSTEM DUE TO THE RISK OF SYSTEM FAILURE. TO AVOID DAMAGE, INJURY, OR DEATH, THE USER OR APPLICATION DESIGNER MUST TAKE REASONABLY PRUDENT STEPS TO PROTECT AGAINST SYSTEM FAILURES, INCLUDING BUT NOT LIMITED TO BACK-UP OR SHUT DOWN MECHANISMS. BECAUSE EACH END-USER SYSTEM IS CUSTOMIZED AND DIFFERS FROM NATIONAL INSTRUMENTS TESTING PLATFORMS AND BECAUSE A USER OR APPLICATION DESIGNER MAY USE NATIONAL INSTRUMENTS PRODUCTS IN COMBINATION WITH OTHER PRODUCTS IN A MANNER NOT EVALUATED OR CONTEMPLATED BY NATIONAL INSTRUMENTS, THE USER OR APPLICATION DESIGNER IS ULTIMATELY RESPONSIBLE FOR VERIFYING AND VALIDATING THE SUITABILITY OF NATIONAL INSTRUMENTS PRODUCTS WHENEVER NATIONAL INSTRUMENTS PRODUCTS ARE INCORPORATED IN A SYSTEM OR APPLICATION, INCLUDING, WITHOUT LIMITATION, THE APPROPRIATE DESIGN, PROCESS AND SAFETY LEVEL OF SUCH SYSTEM OR APPLICATION.
Contents

About This Manual
Organization................................................................................................................... ix
Conventions ................................................................................................................... ix
  Format Conventions ........................................................................................x
  Code Examples or Program Output ..................................................x
  Symbol Conventions .......................................................................................x
  Environment Variables .........................................................................................x
Related Publications .....................................................................................................xi

Chapter 1
Installation Overview and Platform Requirements
  Installation Overview ............................................................................................ 1-1
  Platform Requirements .......................................................................................... 1-1
    Hardware Requirements ...................................................................................... 1-2
    Software Requirements ........................................................................................ 1-2
    Compatible Compilers and Operating System Versions ................................. 1-3
      Minimum Disk Space Requirements ................................................1-3
  Installation Configurations ..................................................................................... 1-4
    Standard Installation............................................................................................ 1-4
    Server Installation............................................................................................... 1-5
    Client Installation............................................................................................... 1-5
  Licensing...................................................................................................................... 1-5
  Troubleshooting Information................................................................................... 1-5

Chapter 2
Software Structure
  Planning Options....................................................................................................... 2-1
  Directory Structure ................................................................................................. 2-1

Chapter 3
Licensing and Terminology
  Licensing Overview.............................................................................................. 3-1
    Floating and Node-Locked Licenses ................................................................. 3-1
    Redundant License Servers .................................................................................. 3-1
    Flexible License Checkout .................................................................................. 3-2
### Contents

- Xmath Licensing Commands ................................................................. 3-3  
  - LICENSECHECKOUT ................................................................. 3-3  
  - LICENSEUSER ................................................................. 3-3  
  - LICENSEINFO ................................................................. 3-5  
  - LICENSEFILE ................................................................. 3-5  
  - NIREFNUM ................................................................. 3-5

- Using Licensing ................................................................................. 3-6  
- License Files .................................................................................. 3-6  
- Proxy License Files ........................................................................ 3-8  
- Compatibility ..................................................................................... 3-8

**Chapter 4**

### Installation and Related Tasks

- Version 7.x Installation ................................................................. 4-1  
  - Requirements ............................................................................. 4-1  
  - Installation Procedure ................................................................. 4-1  
  - License Installation ................................................................. 4-4  
- Installing Other Components ................................................................. 4-6  
  - Installing Altia Design Animation ............................................. 4-6  
  - Installing Altia FacePlate ................................................................. 4-7  
  - Installing the Standalone License Manager ................................. 4-7  
  - Installation Procedure ................................................................. 4-8  
  - Installing Redundant License Servers ............................................. 4-8

- Updating a License File ....................................................................... 4-9
- Using Online Help ............................................................................... 4-9  
- Printing Files ...................................................................................... 4-9
- Installation-Related Tasks ..................................................................... 4-9  
  - Setting Up a User Environment for Printing .................................. 4-9  
  - Running Multiple MATRIXx Versions ............................................ 4-10  
  - Recording Your Reference Number ............................................... 4-10  
  - Moving the MTXHOME Directory Tree to Another Directory .................. 4-10  
  - Configuration Management Tasks .................................................. 4-10  
  - Troubleshooting Your Installation .................................................. 4-11  
  - Virus Scanners and Utility Software ................................................ 4-11  
  - Temp Directory Usage During Install ............................................. 4-12  
  - License Servers .............................................................................. 4-12

- Uninstalling Version 7.x ...................................................................... 4-13
Chapter 5
FLEXlm Licensing Tools

FLEXlm Utilities ................................................................. 5-1
lmgrd ........................................................................... 5-1
lmstat ........................................................................ 5-2
lmreread ....................................................................... 5-3
lmhostid ....................................................................... 5-3
lmdiag ........................................................................ 5-4
lmver .......................................................................... 5-4
lmborrow ..................................................................... 5-4

Initiating Borrowing ................................................... 5-5
Clearing the Borrowed License Setting .................... 5-6
Determining Borrowed License Status ..................... 5-6
Returning a Borrowed License Early ......................... 5-6

lmutil .......................................................................... 5-7
lmttools ...................................................................... 5-7

Configuration Using License File .............................. 5-8
Configuration Useing Services ..................................... 5-8

Resolving Problems .................................................... 5-8
General Debugging Tips ............................................. 5-8
Support Issues ............................................................. 5-9

Troubleshooting License Manager Problems ............. 5-10
Host ID Problems ........................................................ 5-10
Connection Problems ................................................ 5-11
Other Client Problems ............................................... 5-12
Other Server Problems .............................................. 5-12

Daemon Log File ............................................................ 5-14
Informational Messages ............................................. 5-14
Configuration Problem Messages ............................. 5-16
Daemon Software Error Messages .............................. 5-17

Appendix A
Technical Support and Professional Services
About This Manual

This manual tells how to install MATRIXx product family version 7.x.

Organization

This manual includes the following:

- Chapter 1, *Installation Overview and Platform Requirements*, defines the version 7.x installation and platform requirements.
- Chapter 2, *Software Structure*, describes the MATRIXx Product Family directory structure and planning options.
- Chapter 4, *Installation and Related Tasks*, gives a detailed explanation of the version 7.x installation procedure and related tasks.
- Chapter 5, *FLEXlm Licensing Tools*, discusses the version 7.x license manager utilities, license manager debugging, and daemon log file.

Conventions

The following conventions appear in this manual:

» The » symbol leads you through nested menu items and dialog box options to a final action. The sequence File»Page Setup»Options directs you to pull down the File menu, select the Page Setup item, and select Options from the last dialog box.

This icon denotes a note, which alerts you to important information.

This icon denotes a caution, which advises you of precautions to take to avoid injury, data loss, or a system crash.

**bold**

Bold text denotes items that you must select or click in the software, such as menu items and dialog box options. Bold text also denotes parameter names.

**italic**

Italic text denotes variables, emphasis, a cross reference, or an introduction to a key concept. This font also denotes text that is a placeholder for a word or value that you must supply.
About This Manual

monospace Text in this font denotes text or characters that you should enter from the keyboard, sections of code, programming examples, and syntax examples. This font is also used for the proper names of disk drives, paths, directories, programs, subprograms, subroutines, device names, functions, operations, variables, filenames, and extensions.

monospace bold Bold text in this font denotes the messages and responses that the computer automatically prints to the screen. This font also emphasizes lines of code that are different from the other examples.

monospace italic Italic text in this font denotes text that is a placeholder for a word or value that you must supply.

Platform Text in this font denotes a specific platform and indicates that the text following it applies only to that platform.

Format Conventions

Code Examples or Program Output
This manual uses a special formatting convention to present code examples or screen output from the installation program. The example format has a numbered heading followed by a line; the end of the example is also followed by a line.

Symbol Conventions

Environment Variables
This manual uses the % character to denote environment variables. For example, %SystemRoot%\system32\drivers\etc\hosts is not an absolute path, because it depends on the definition of %SystemRoot%. The most commonly used environment variable in this document is %MTXHOME%, which is used to refer to the MATRIXx Product Family installation directory.
Related Publications

National Instruments provides a library of publications to support its products. Of special interest to the users of this publication are the installation guides, summarized as follows:

- MATRIXx Product Family CD and booklet *Installation Guide (Windows)*
- *FLEXlm End User Manual* (from Macrovision Corporation)
- For additional documentation, refer to the *MATRIXx Help* or the National Instruments Web site at [ni.com/matrixx](http://ni.com/matrixx).
Installation Overview and Platform Requirements

This chapter provides an overview of hardware and software requirements for MATRIXx version 7.x.

Installation Overview

MATRIXx version 7.x includes installation software that performs a complete installation for the product. This includes three setup types as described in Table 1-1.

<table>
<thead>
<tr>
<th>Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Client</td>
<td>Installs client software only.</td>
</tr>
<tr>
<td>Server</td>
<td>(Windows 2000/NT/XP) Installs the product software on a network server.</td>
</tr>
<tr>
<td>Standard</td>
<td>Installs the product software on a local PC.</td>
</tr>
</tbody>
</table>

**Note** The Server and Standard installation processes require approximately 135 MB of disk space during the installation process. The product software requires approximately 24 to 48 MB of RAM.

The installation software includes the Flexible License Manager (FLEXlm).

**Note** MATRIXx can be installed on a file server using a shared license manager.

Platform Requirements

National Instruments supports the MATRIXx version 7.x software in the hardware and software environments described in the following sections.
Hardware Requirements

The following requirements apply to all computers that will run MATRIXx on Windows 2000/NT/XP:

- Pentium III 500 MHz or equivalent.
- Minimum 32 MB RAM, 64 MB recommended.
- A video card that supports a minimum of 256 colors at 800 × 600 resolution; 65,536 colors at 1024 × 768 resolution is recommended; True Color setting (16 million) is supported.
- A CD-ROM drive.
- Approximately 135 MBs of disk space to complete a full MATRIXx installation. Refer to Table 1-3 for details.
- A 2-button Microsoft compatible mouse, with a 3-button Logitech mouse or equivalent preferred.

Note: You can change the number of colors for your display through Start>Settings>Control Panel>Display>Settings.

Software Requirements

The following requirements apply to all computers that will run MATRIXx on Windows 2000/NT/XP:

- The MATRIXx software requires Windows 2000, Windows NT version 4.0 or Windows XP. Supported installations include English, Japanese, and German.
- If you want to link your own C code to Xmath or SystemBuild, you must purchase and install a copy of Microsoft Visual C++ or 6.0. For FORTRAN you must install a copy of DIGITAL Visual Fortran 5.0 or 6.0.

Note: DIGITAL Visual Fortran 5.0 for Windows NT (releases 408 through 333E) requires a patch for the linker before it will work properly. Contact Digital at www.digital.com/fortran to acquire the patch.

- Floating licenses require properly functioning TCP/IP networking which includes Winsock 1.1 or later.
- Internet Explorer 5 or later is required for MATRIXx Help.
Compatible Compilers and Operating System Versions

The MATRIXx version 7.x software was developed and tested with the operating system versions and compiler versions listed in Table 1-2. These configurations are recommended for optimal compatibility.

Other operating system versions and compiler versions may be compatible with the MATRIXx version 7.x software, please check the National Instruments Support page at ni.com/support or contact Technical Support at support@ni.com or (877) 493-2404.

Table 1-2. Verified Compilers

<table>
<thead>
<tr>
<th>Compiler</th>
<th>Windows 2000, Windows NT 4.0, or Windows XP</th>
</tr>
</thead>
<tbody>
<tr>
<td>C or C++</td>
<td>Microsoft Visual C / C++ version 6.0</td>
</tr>
<tr>
<td>FORTRAN</td>
<td>DIGITAL Visual Fortran version 6.0</td>
</tr>
</tbody>
</table>

Caution  Other compilers may work in certain cases, but they are not supported. NI recommends against using unsupported compilers.

Minimum Disk Space Requirements

The minimum space requirements for the MATRIXx software on a Windows host are shown in Table 1-3. A complete installation requires approximately 135 MB of disk space during the MATRIXx installation process. This may be significantly larger for large disk partitions that use a FAT format.

Table 1-3. Minimum Disk Space Requirements

<table>
<thead>
<tr>
<th>Product</th>
<th>Space Required</th>
</tr>
</thead>
<tbody>
<tr>
<td>MATRIXx</td>
<td>135 MB</td>
</tr>
<tr>
<td>License Manager</td>
<td>5 MB</td>
</tr>
<tr>
<td>Altia Design Animation (optional)</td>
<td>45 MB</td>
</tr>
<tr>
<td>Altia FacePlate (optional)</td>
<td>25 MB</td>
</tr>
<tr>
<td>Full installation</td>
<td>~210 MB</td>
</tr>
</tbody>
</table>
Installation Configurations

MATRIXx supports three installation types on Windows hosts: standard, server, and client. A PC can only support one of these installation types at a time for a given version of MATRIXx. If you want to change installation types for a version, you should uninstall and then reinstall that version. Multiple different versions of MATRIXx software can be installed at one time on the same machine, including different installation types.

![Typical Client-Server Configuration](image)

**Figure 1-1.** Typical Client-Server Configuration

### Standard Installation

A standard installation installs the full set of MATRIXx software on the local Windows system. Typically, this type of installation is not visible to other machines on the network because it uses a local installation path not accessible to other systems.

If you perform a standard install specifying the installation directory with a valid pathname in Uniform Naming Convention (UNC) format, for example:

```
\\computername\sharename\ni
```
then the installation will be visible to other users similar to a server installation.

**Server Installation**

A server installation, installs the full set of MATRIXx software on the local Windows system similar to a standard installation. However, a server installation will, if necessary, automatically create a directory share with a user specified name for the local install directory, thus ensuring that the software is visible to other client systems on a network. A server installation can also accept a valid UNC format pathname for the installation directory path.

**Client Installation**

A client installation (requiring only 5 KB of disk space) creates shortcuts to an existing server installation of MATRIXx and updates any Windows shared system files on the client required to run the MATRIXx software. It does not place any other software on the client system. During a client installation of MATRIXx, you will be asked to specify the network pathname of an existing MATRIXx server installation.

All client machines that will use MATRIXx software must be able to access the %MTXHOME% root directory on the server machine.

**Licensing**

MATRIXx uses FLEXlm licensing utilities. For licensing information, refer to Chapter 3, *Licensing and Terminology*, Chapter 5, *FLEXlm Licensing Tools*, or the FLEXlm End User Manual on the MATRIXx Bookshelf.

**Troubleshooting Information**

For troubleshooting tips, refer to the *Troubleshooting Your Installation* section of Chapter 4, *Installation and Related Tasks*. For additional troubleshooting assistance contact support@ni.com.
Software Structure

This chapter describes installation planning options and version 7.x directory structure.

Planning Options

Before starting the installation, you should make decisions about how and where you want to install MATRIXx tools. These issues must be addressed before you start the installation procedure detailed in Chapter 4, Installation and Related Tasks.

MATRIXx version 7.x must be installed in a different installation directory if you plan to keep versions prior to 6.x. The version 7.x installation will not affect an older version of MATRIXx software as long as you do not use the same parent directory. You do not have to do any extra work to keep the older version of MATRIXx, which will still use its own license manager.

You can install a copy of MATRIXx on a local node using either floating or node-locked licensing, or, you can use a file server (a shareable disk) and a shared license manager to install the MATRIXx software on a network server. The directory structure detailed here is of interest in both situations, as it handles multiple versions and multiple platforms.

Directory Structure

The directory structure shown in Figure 2-1, shows the MATRIXx product structure, which enables you to manage the software in a central location in a network environment. This structure reduces the system administration issues of multiple installations for a given platform, because installation can be completed solely on a file server using a common license manager. Then a simple client installation on a networked node will let you access the file server installation. You can safely install multiple versions of MATRIXx version 7.x into a common root installation directory (%MTXHOME%).
Chapter 2  Software Structure

**Note**  All machines that will use MATRIXx software must be able to access the %MTXHOME% root directory. %MTXHOME% and installation_directory (referred to elsewhere in this document) are equivalent.

The commands used to invoke the MATRIXx suite of products can be found in the %MTXHOME%\bin directory.

![Diagram of MATRIXx Product Family Sample File Structure]

*Figure 2-1. MATRIXx Product Family Sample File Structure*

**Note:** version has the form 7x.x
Licensing and Terminology

This chapter provides an overview of licensing and describes licensing-related terminology and tasks. Version 7.x includes a license daemon, \texttt{lmgrd.exe} which controls all National Instruments product licenses. \texttt{lmgrd.exe} resides in the directory \texttt{NILM} and must be running on your license server (or on all three if you have a redundant license server configuration). It does not have to be on the node where you install version 7.x.

Licensing Overview

MATRIXx licensing includes the following features:
- Floating and node-locked licenses
- Redundant license servers (optional)
- Flexible license checkout

Floating and Node-Locked Licenses

License configurations for counted floating licenses, node-locked licenses, and evaluation licenses are available on Windows 2000/NT/XP systems. To check out a floating license or counted node-locked licenses, a client system must be connected to the network and have properly functioning TCP/IP software with Winsock support. Evaluation and uncounted node-locked licenses do not require that you have a running license server or network support.

Windows 2000/NT/XP systems can check out floating licenses from either a Windows 2000/NT/XP or UNIX license server. To check out licenses from a network license server, a Windows system must reference a copy of the same \texttt{license.dat} file used by the network server, or it must reference a proxy license file (refer to the \textit{Proxy License Files} section).

Redundant License Servers

Redundant license servers are a set of three nodes designated to serve the same license file. If any node fails, the other two nodes will still be available to serve the licenses for MATRIXx.
To support the redundant license server scheme, National Instruments requires the following information for the three servers: the `computername` and `hostid` (that is, an Ethernet address) for each server. Windows 2000/NT/XP systems can check out floating licenses from redundant systems containing any combination of Windows and UNIX servers.

NI issues redundant license server keys once you provide the `hostid` of the three servers. At a minimum, you need to run the standalone license server installation program and start the license server on each machine. Follow the instructions described in the Installing Redundant License Servers section of Chapter 4, Installation and Related Tasks.

Figure 3-1 shows a typical redundant license-server configuration.

![Typical Redundant License Server Configuration](image)

### Flexible License Checkout

With MATRIXx version 7.x licensing, a feature (product component) is checked out as you use it. A feature stays checked out until you exit that product component. For example, Xmath and SystemBuild modules are checked out when first used and stay checked out until you exit Xmath or SystemBuild. SystemBuild is checked out when you launch the Catalog Browser (by starting SystemBuild) and stays checked out until you exit SystemBuild. The flexible license checkout feature is also known as on-demand checkout.
Xmath Licensing Commands

Xmath has the following license-related commands:

- **LICENSECHECKOUT** for checking out features for future use
- **LICENSEUSER** for displaying assigned licenses for any feature names specified
- **LICENSEINFO** for displaying a license report for your site
- **LICENSEFILE** for displaying the current license file search path
- **ISIREFNUM** for identifying your reference number

All of these commands must be run from the Xmath Commands window.

**LICENSECHECKOUT**

LICENSECHECKOUT is an intrinsic command that checks out a license for the listed feature or features. Run LICENSEINFO to see a list of feature names. Features are specified as strings, and the name must be exactly as displayed by LICENSEINFO.

Although features are normally checked out on-demand, you can use LICENSECHECKOUT to reserve features for future use (for example, for a scheduled demo or presentation). They are checked in when you exit Xmath.

This command can be placed in a global or local startup.ms file to check out required features at startup. The syntax is as follows:

```
LICENSECHECKOUT feature1,feature2,...featureN
```

For example:

```
LICENSECHECKOUT"Xmath","Control","Sysid","Sysid2","sysbld","case"
```

**LICENSEUSER**

The LICENSEUSER utility displays assigned licenses for any feature names specified. The default feature is Xmath if no argument is specified. LICENSEUSER accepts feature names in string form. To see a list of the feature names for products you have purchased (for example, aca indicates AutoCode Ada), issue the LICENSEINFO command. The syntax for LICENSEUSER is as follows:

```
LICENSEUSER feature1,feature2,...featureN
```
Typical output is shown in Example 3-1.

**Example 3-1 LICENSEUSER output**

```
licenseuser *xmath*,*aca*
```

**Users of Xmath:**

- **Number of licenses purchased**: 10
- **Number of unused licenses**: 4

<table>
<thead>
<tr>
<th>User</th>
<th>Node Name</th>
<th>Starting Time</th>
</tr>
</thead>
<tbody>
<tr>
<td>muemura</td>
<td>sampras</td>
<td>Thu May 29 19:33:44 1999</td>
</tr>
<tr>
<td>lynch</td>
<td>tribble</td>
<td>Thu May 29 19:34:36 1999</td>
</tr>
<tr>
<td>sanjay</td>
<td>castaway</td>
<td>Sat May 31 19:01:04 1999</td>
</tr>
<tr>
<td>rpizzi</td>
<td>castor</td>
<td>Mon Jun  2 15:21:54 1999</td>
</tr>
<tr>
<td>dawn</td>
<td>venus</td>
<td>Wed Jun  4 11:05:06 1999</td>
</tr>
<tr>
<td>uma</td>
<td>sampras</td>
<td>Mon Jun  9 13:45:47 1999</td>
</tr>
</tbody>
</table>

**Users of aca:**

- **Number of licenses purchased**: 4
- **Number of unused licenses**: 2

<table>
<thead>
<tr>
<th>User</th>
<th>Node Name</th>
<th>Starting Time</th>
</tr>
</thead>
<tbody>
<tr>
<td>muemura</td>
<td>sampras</td>
<td>Thu May 29 19:56:44 1999</td>
</tr>
<tr>
<td>uma</td>
<td>sampras</td>
<td>Mon Jun  9 13:51:47 1999</td>
</tr>
</tbody>
</table>
Chapter 3  Licensing and Terminology

**LICENSEINFO**

**LICENSEINFO** displays a license report for your site as shown in Example 3-2.

**Example 3-2  LICENSEINFO license report**

```
licenseinfo

License File: C:\Program Files\National Instruments\MATRIDX\mx_71.1\NILM\license.dat
License Server Name: hardrock
License Server ID: 18000000

<table>
<thead>
<tr>
<th>Module Name</th>
<th>Feature Name</th>
<th>Expiration Date</th>
<th>Type</th>
<th>Seats</th>
<th>Licensed Node</th>
</tr>
</thead>
<tbody>
<tr>
<td>Xmath</td>
<td>Xmath</td>
<td>31-Jan-2002</td>
<td>Floating</td>
<td>10</td>
<td></td>
</tr>
<tr>
<td>Control Design Module</td>
<td>Control</td>
<td>31-Jan-2002</td>
<td>Floating</td>
<td>10</td>
<td></td>
</tr>
<tr>
<td>SystemBuild</td>
<td>sysbld</td>
<td>31-Jan-2002</td>
<td>Floating</td>
<td>10</td>
<td></td>
</tr>
<tr>
<td>AutoCode C Single Processor</td>
<td>acc</td>
<td>31-Jan-2002</td>
<td>Node-Locked</td>
<td>4</td>
<td>80379b46</td>
</tr>
<tr>
<td>Model Reduction Module</td>
<td>Modred</td>
<td>31-Jan-2002</td>
<td>Floating</td>
<td>10</td>
<td></td>
</tr>
<tr>
<td>Interactive Animation Module</td>
<td>Icdm</td>
<td>31-Jan-2002</td>
<td>Floating</td>
<td>10</td>
<td></td>
</tr>
<tr>
<td>Robust Control Module</td>
<td>Robust</td>
<td>31-Jan-2002</td>
<td>Floating</td>
<td>10</td>
<td></td>
</tr>
<tr>
<td>RT/Fuzzy Module</td>
<td>blk_fuz</td>
<td>31-Jan-2002</td>
<td>Floating</td>
<td>10</td>
<td></td>
</tr>
<tr>
<td>AutoCode Ada Single Processor</td>
<td>aca</td>
<td>31-Jan-2002</td>
<td>Floating</td>
<td>10</td>
<td></td>
</tr>
<tr>
<td>DocumentIt</td>
<td>docit</td>
<td>31-Jan-2002</td>
<td>Node-Locked</td>
<td>4</td>
<td>80379b46</td>
</tr>
</tbody>
</table>
```

**LICENSEFILE**

The **LICENSEFILE** command displays the current license file search path. The syntax and example output are as follows:

```
LICENSEFILE

License files searched by MATRIXx are as follows:
\\butters\ni\NILM\license.dat
\\butters\ni\NILM\tplic.dat
```

**NIREFNUM**

The **NIREFNUM** command displays the reference number (also known as your customer identification number). You should have this number ready if you plan to call customer support.

The syntax and example output are as follows:

```
NIREFNUM

Your NI Reference Number is : CUSTOMID99
```
Using Licensing

With concurrent licensing, you can have a different number of licenses for each module or application. An application or module is either available on a first-come, first served basis, or node-locked to a given CPU. Some common uses of licensing are as follows:

- To see all the features your site has purchased or to view the license expiration date, use the command LICENSEINFO.
- To see who is using a given feature, or to see if a feature is available, use the LICENSEUSER command and specify the desired feature.
- To see the current license file search path, use the command LICENSEFILE.
- To reserve features for future use (for example, for a scheduled demo or presentation), use the LICENSECHECKOUT feature.

The initial distribution of licenses is determined at the time of the installation; to change licensing, your system administrator must get a new key from National Instruments. To generate a new license file from this key, run the standalone license installation as described in the Updating a License File section of Chapter 4, Installation and Related Tasks.

National Instruments uses the FLEXlm license manager, a product of Macrovision Corporation. If you have license manager questions beyond the scope of this document, refer to the FLEXlm End User Manual on the MATRIXx Bookshelf. For additional information about FLEXlm, refer to the Macrovision FAQ at www.macrovision.com/solutions/esd/support/lmwinfaq.htm.

License Files

The set of licensed features available for checkout by a MATRIXx user are contained in one or more license files, each containing encrypted feature lines.

The following default license files are used by the MATRIXx products:

- %MTXHOME%\NILM\license.dat—This primary license file contains feature lines for built-in MATRIXx features. The license.dat file is generated from NI provided authorization keys during the MATRIXx or standalone license manager installation procedures.
Chapter 3  Licensing and Terminology

- **%MTXHOME%\NILM\tplic.dat**—This optional file contains license feature lines for third-party MATRIXx components. The encrypted feature lines in this file and the instructions for using the file will typically be provided by your third-party supplier. Multiple features from different third-party suppliers can be placed in this file. Typically, this file will also contain the same SERVER and DAEMON lines as license.dat. This file is not modified during a MATRIXx or license manager installation, nor is it deleted by uninstall procedures.

The search paths used to locate these license files are set in the environment variable %NILM_LICENSE_FILE% by the MATRIXx product launching scripts. The above NI license file paths are prepended to any existing definition of %NILM_LICENSE_FILE%, thus allowing access to other MATRIXx or non-MATRIXx products also licensed by a FLEXlm license manager.

Normally, the only things you can change in a license file are:

- The hostname (not the hostid).
- The port number on the SERVER line. If this port number is already in use, the license daemon (lmgrd) will report **Address In Use**. The default port number used in MATRIXx 7.x license files is 27001, whereas for prior releases it was 5200. A valid number is any unused port number between 1025 and 64000. Beginning with MATRIXx 7.x, the port number can be removed and the FLEXlm license manager will serve on any available FLEXlm reserved port in the range 27000-27009. For redundant license servers, however, you must use a fixed port number.
- The path to the vendor daemon executable on the DAEMON line. (The vendor daemon is named nilm.)
- name=value pairs on a FEATURE line can be changed if name is lowercase.

Redundant license server files contain three SERVER lines. The first SERVER line defines the primary license server. The second and third lines define the secondary license servers.
Proxy License Files

If you are using a floating-license server, each licensing client needs a copy of the same license file used by the server. Alternatively, to avoid copying the license server file to each installation of MATRIXx, you can create a proxy license file in the NILM directory of each MATRIXx installation. This approach can be used for both single and redundant license server configurations. The proxy license file (license.dat) can be constructed by taking the SERVER line or lines from the license server file and then adding a line containing USE_SERVER. For example, a proxy license file for a single server configuration would be as follows:

```
SERVER host1 17003456 27000
USE_SERVER
```

A proxy license file for a redundant server configuration, for example, would be:

```
SERVER host1 17003456 27002
SERVER host2 17004355 27002
SERVER host3 17007ea8 27002
USE_SERVER
```

Unless your server nodes are changed, you will not have to update the license file for each individual MATRIXx installation when the server license file is updated.

Although a proxy license file is the preferred way to reference the actual license file used by a remote license server, you can also use a `port@host` definition for either of the environment variables NILM_LICENSE_FILE or MTXLMD_LICENSE_FILE. `port` is the license file port number and `host` is the hostname, and both are taken from the SERVER line of the actual license file. MTXLMD_LICENSE_FILE is similar in use to NILM_LICENSE_FILE, except that it is specific to the MATRIXx license manager daemon and overrides any concurrent definition of NILM_LICENSE_FILE.

Compatibility

The MATRIXx 7.x license manager uses the vendor daemon name `nilm` (versus isilmd in prior releases) and the default port number 27001 (versus 27000 in prior releases). As a result, the MATRIXx 6.x (ISILM) and MATRIXx 7.x (NILM) license manager can coexist with MATRIXx 5.x running on the same machine. Since version 6.x/7.x software must be installed in a different directory `%MTXHOME%` directory than MATRIXx 5.x,
versions of the MATRIXx license manager for MATRIXx 5.x do not have to be stopped to install the new software. MATRIXx 6.x (ISILM) and MATRIXx 7.x (NILM) can share the same %MTXHOME% directory since their license directories are different. You would only need to kill the older license manager daemon (lmgrd) if you choose to remove the old software.

Because of the addition of new features and new license manager functionality, license keys issued prior to MATRIXx 7.x cannot be used to regenerate a license file for version 7.x.

**Licensing Requirements**

In order to obtain a license, you must provide the `computername` and `hostid` for each license server machine.

**Finding the Host ID**

FLEXlm uses different machine identifications for different machine architectures. An Ethernet address is the preferred “host ID” for a Windows platform. An Ethernet address is a 6-byte quantity, with each byte specified as two hexadecimal digits. Specify all 12 hex digits when using an Ethernet address as a host ID.

The program `%MTXHOME%\NILM\lmhostid` will print the Ethernet host ID that FLEXlm expects to use on any given machine. For floating licenses, you must provide an Ethernet address. For node-locked licenses, an Ethernet address is preferred, but a disk volume serial number for drive C: can be used. A disk volume serial number is an 8-character string with the dash omitted. Table 3-1 lists alternate methods to obtain the required host ID.

<table>
<thead>
<tr>
<th>Host ID</th>
<th>DOS Shell Command</th>
<th>Example</th>
</tr>
</thead>
<tbody>
<tr>
<td>Ethernet address</td>
<td>ipconfig /all</td>
<td>08002be5a721</td>
</tr>
<tr>
<td></td>
<td>(Physical address)</td>
<td></td>
</tr>
<tr>
<td>Disk volume serial number for C: drive</td>
<td>c: vol</td>
<td>1F68-5D8A</td>
</tr>
<tr>
<td></td>
<td>(disregard dash)</td>
<td></td>
</tr>
</tbody>
</table>
Finding the Computer Name

The computer name is defined at the time Windows is installed. To see the computer name, select Start»Settings»Control Panel»Network. The Identification tab appears; the first entry is the computer name.

Contacting National Instruments

Contact NI in one of the following ways:

- Complete a Key Request Form (included with your software) and fax it to (512) 683-9007.
- Send email with the information asked for in the Key Request Form to matrixx@ni.com.
- Call (877) 493-2404 between 7 a.m. and 7 p.m. Central Time, Monday through Friday to speak with a MATRIXx representative to assist you with obtaining your license key.

NI supplies the authorization key(s) and checksum(s) used to generate the license file, which enables you to use the packages and modules you purchased. An authorization key or checksum is an alphanumeric string that does not contain the numbers 0, 1, or 5 to avoid confusion with the uppercase letters O, I, and S.
Installation and Related Tasks

This chapter describes how to install MATRIXx software, including any optional components such as Altia Design, and perform related tasks.

Version 7.x Installation

This section provides a detailed description of how to install MATRIXx product family version 7.x software on a client, server, or standalone PC.

Requirements

- Your system must meet the hardware and software requirements for your platform specified in Chapter 1, Installation Overview and Platform Requirements.
- Floating licenses require properly functioning TCP/IP networking which includes Winsock version 1.1 or later.

Installation Procedure

Before running the installation program, you will need the reference number, authorization key, and checksum.

Note Before beginning the installation make sure you exit from any other software and stop all virus scan software.

1. Place the version 7.x CD in the CD-ROM drive.
2. Use the Windows Explorer to find the setup.exe file in the MATRIXx directory and launch it.
3. After the Welcome screen (not shown), the following dialog box prompts you for the location of your installation directory.
4. Setup defaults to c:\Program Files\National Instruments\MATRIXx but you can use the Browse button to select any other local (or server) location.

5. After you click Next, the Setup Type dialog box prompts you to select Client, Server, or Standard (the default). Select the appropriate type as described in the Installation Configurations section of Chapter 1, Installation and Related Tasks.
a. If you select Client, you will be prompted for the path to an existing MATRIXx server installation.

b. If you select Server, you will be prompted for the Sharename for the installation directory unless you entered a universal naming convention (UNC) pathname as the install location.
6. Setup copies the MATRIXx product files, updates any shared components, and launches the license manager installation.

License Installation

7. The License Manager (NILM) installation asks you whether you want to generate a new license file (license.dat).

Note If you don’t already have a version 7.x license file, click Yes to generate one. If you intend to access a floating license provided by another host, click No to avoid generating a new license. Then when the installation is complete, use a text editor to create a proxy license file named license.dat in the installation_directory\NILM folder as described in the Proxy License Files section of Chapter 3, Licensing and Terminology.
Chapter 4  Installation and Related Tasks

a. If you click No, go to step 8.
b. If you click Yes, the installation prompts you for your reference number, authorization key, and checksum.

The version 7.x software has an option for running redundant servers. If you are using the redundant server option, you will also be prompted to enter the hostnames of the additional license servers.

After you enter valid data, the License File dialog (not shown) displays the generated license file.

c. You will be prompted to start the license server, unless you have an evaluation license.
Chapter 4  Installation and Related Tasks

Note  The license server is not required for an Evaluation license. For other licenses, the license server can always be started later using the command: `lmgrd -c license.dat -l debug.log`.

8. Upon completion, you can select to display the README file (an ASCII version of the release notes that are also available in the MATRIXx Help) or exit the installation.

Note  In most cases rebooting is not necessary, but Setup will prompt you to reboot if required. If you have just completed a server installation, be sure to set your desired access permissions for the MTXHOME directory share.

9. If you are installing redundant license servers, complete the procedure described in the Installing Redundant License Servers section.

10. To start Xmath version 7.x, select Start»National Instruments»MATRIXx mx_71.1»Xmath, or enter either of the following from the command prompt:
    
    \begin{verbatim}
    installation_directory\bin\xmath
    \end{verbatim}
    
    or
    
    \begin{verbatim}
    installation_directory\bin\xmath -v version
    \end{verbatim}
    
    where `version` is the installation version that you just installed, or one of the versions in `installation_directory\bin`.

11. (Optional) After you have verified that Xmath starts successfully, go to the Installing Other Components section, if you plan to use Altia Design animation or Altia FacePlate.

Installing Other Components

This section describes the installation procedures for installing optional MATRIXx components.

Installing Altia Design Animation

Because the Altia Design software uses the MATRIXx license manager, you must have either MATRIXx or the standalone license manager installed.
To install Altia Design animation software, complete the following steps:

1. Verify that the MATRIXx CD is in your CD-ROM drive.
2. Use the Windows Explorer to find the setup.exe file in the Altia\Design directory, and launch it.
3. When the installation dialog prompts you for the installation directory, specify MTXHOME where MTXHOME is your existing MATRIXx installation directory.

**Note** If you choose not to install within your current MTXHOME directory, you must edit the Altia code words file after installation is complete to identify the path of the NI license manager file (license.dat). Select Start»Programs»Altia Design»Codeword File and specify the path to the MATRIXx license file.

**Installing Altia FacePlate**

Because the Altia FacePlate software uses the MATRIXx license manager, you must have either MATRIXx or the standalone license manager installed.

To install Altia FacePlate software, complete the following steps:

1. Verify that the MATRIXx CD is in your CD-ROM drive.
2. Use the Windows Explorer to find the setup.exe file in the Altia\Face directory, and launch it.
3. When the installation dialog prompts you for the installation directory, specify MTXHOME where MTXHOME is your existing MATRIXx installation directory.

**Note** If you choose not to install within your current MTXHOME directory, you must edit the Altia code words file after installation is complete to identify the path of the NI license manager file (license.dat). Select Start»Programs»Altia FacePlate»Codeword File and specify the path to the license file.

**Installing the Standalone License Manager**

The standalone license manager installation, which populates only the NILM subdirectory tree, is a subset of the full MATRIXx installation. It can be used to provide support for other standalone product installations such as Altia animation, which require MATRIXx licensing but may not need the full MATRIXx product set to function. In addition, it can provide the required licensing installation on single or redundant license servers.
Chapter 4 Installation and Related Tasks

Installation Procedure

Before running the installation program, you will need the NI reference number, authorization key, and checksum.

1. Place the version 7.x CD in the CD-ROM drive.
2. Use the Windows Explorer to find the setup.exe file in the NILM directory and launch it.
3. Select the Install License Manager setup type and follow the dialog prompts to complete the installation.
4. Each installation of MATRIXx installed in a separate location can access the license server via the proxy license file described in the Proxy License Files section of Chapter 3, Licensing and Terminology.

Installing Redundant License Servers

At a minimum, installing redundant license servers requires the installation of standalone license manager software and starting the license manager daemon on two other nodes in addition to the primary license server. Special license keys are required for a redundant license server configuration.

To install a typical redundant license server configuration, complete the following steps:

1. Perform a standalone license manager installation on the primary license server (refer to Installing the Standalone License Manager section) or a complete MATRIXx installation if you want this machine to also serve the MATRIXx application files (refer to the Version 7.x Installation section). Either procedure requires generating a license file and starting the license daemon.
2. On each of two secondary license servers, run either the standalone license manager installation (refer to the Installing the Standalone License Manager section) or a complete MATRIXx installation (if you want to replicate all the MATRIXx files), and then start the license daemon on each machine.

Note Rather than generating the license file on each secondary license server, copy license.dat from the NILM directory of the primary server to the NILM directory of each secondary server before starting the license daemons. Edit the DAEMON line of each secondary copy of the license.dat file to point to the daemon path that contains nilm.exe for that server.
3. Each separate installation of MATRIXx can access the license server with a proxy license file as described in the Proxy License Files section of Chapter 3, Licensing and Terminology.

### Updating a License File

To update a license file, run the standalone license manager installation as described in the Installing the Standalone License Manager section and select the Update License File setup type.

### Using Online Help

MATRIXx version 7.x provides a hypertext markup language (HTML) help system. MATRIXx Help is a self-contained system with multiple hypertext links from one component to another. This help system, augmented by online and printed manuals, covers most MATRIXx topics except for installation.

MATRIXx Help runs with Internet Explorer.

### Printing Files

To print a Help topic, go to the Topics Hierarchy, and select a topic (for example, Dynamic Systems»Control Design) and then right click and hold. An Internet Explorer window displays with one of the options saying “Open Frame in New Window.” When the Help topic is in the new window, select Print (or any other standard Internet Explorer capability).

### Installation-Related Tasks

#### Setting Up a User Environment for Printing

The environment variable %XMATH_PRINT% defines the printer for MATRIXx. The following are sample definitions for %XMATH_PRINT%, where \pluto\hp4 should be replaced by your printer.

Set the following using the Control Panel system applet:

```plaintext
set XMATH_PRINT=%MATRIXX%\xmath\bin\xmprint \pluto\hp4
```
Running Multiple MATRIXx Versions

You can install multiple versions of MATRIXx version 6.x or later under a common directory. If you have multiple versions installed, the following command lets you run a selected version:

```
installation_directory\bin\command_name -v version
```

where `command_name` is `xmath`, `sbsim`, `autostar`, `ia`, `encrypt`, `mtxdemo`, or `mtxhelp`, and `version` is one of the versions in `installation_directory\bin`. The version string appears as a suffix on the launching scripts.

Recording Your Reference Number

To help us provide rapid support when you call National Instruments, the installation procedure prompts you for the 10-character reference number while installing MATRIXx 7.x or the license manager. Your reference number is stored in the file `%MTXHOME%\NILM\config.txt`. If you do not have a reference number, you can obtain one from National Instruments when you request your Authorization Key and enter it into the first line of the `config.txt` file as follows:

```
REFERENCE NUMBER: 10_character_string
```

You can use the Xmath `NIREFNUM` command to display the reference number.

Moving the MTXHOME Directory Tree to Another Directory

If you want to move the `MTXHOME` directory tree to another directory after installing MATRIXx version 7.x, the preferred method is as follows:

1. Save the `license.dat` file (if required).
2. Uninstall the MATRIXx software after stopping the license daemon.
3. Reinstall MATRIXx in the new directory location.
4. Copy the `license.dat` file to the new directory location.
5. Restart the license daemon.

Configuration Management Tasks

The MATRIXx configuration management (CM) utility provides integration between SystemBuild and the ClearCase, Merant PVCS, Perforce and Microsoft Visual SourceSafe CM tools. Before using the utility, you must install the CM license key (FEATURE sysbldcm). For
information about obtaining and installing license features, refer to Chapter 3, *Licensing and Terminology*.

The ClearCase, Merant PVCS, Perforce and Microsoft Visual SourceSafe CM tools all have their own native working environment that must be installed and functioning before the CM tool can be used with SystemBuild. SystemBuild uses the Microsoft Common Source Code Control interface to connect with these tools. When one of these CM tools is installed, entries are written to the Windows registry. These registry entries allow SystemBuild to connect to the CM tool.

When you connect to CM, you must set your working directory to the working directory for the selected project. The CM tool supports working with one project at a time (there is a 1:1 relationship between the working directory and a project).

**Troubleshooting Your Installation**

The following sections provide some troubleshooting tips.

**Virus Scanners and Utility Software**

It is important that virus scanner software be disabled before installing MATRIXx. Virus scanners and some utility software can interfere with the ability of the InstallShield program to run external programs during installation. External programs are used during install to set the installation path in MATRIXx launching scripts and to generate the license file. Symptoms of external program failure are that the MATRIXx launching scripts do not have the correct installation path set in environment variables such as `%MTXHOME%`, thus causing Xmath and other programs to fail to launch. If license file generation fails during an install, Xmath may report a license file error when trying to run.

It is possible to run the external programs from the command line after an install to fix these problems without performing a complete reinstall. You can invoke each of the two programs listed below without providing parameters to get a usage message that describes the required command-line arguments.

- To generate a new license file from the Command Prompt window, change directory to `%MTXHOME%\NILM` and run the license file generator `engine.exe`. You should use the `-nolog` parameter when generating the license from the command-line. This program replaces the `license.dat` file in the `%MTXHOME%\NILM` directory.
To reset the installation path in the MATRIXx launching scripts, run the Perl program moveinstall.pl. You can invoke this program as follows to get its usage description:

```
%MATRIXX%\perl\perl.exe %MATRIXX%\version\moveinstall.pl
```

where %MATRIXX% is the MATRIXx product subdirectory as shown in Figure 2-1, MATRIXx Product Family Sample File Structure.

### Temp Directory Usage During Install

InstallShield uses the Windows TEMP folder during installations. It is therefore important that sufficient disk space exist on the disk drive containing TEMP, which may be different from the drive where you are installing MATRIXx. An installation can fail when there is insufficient disk space on the TEMP drive. On rare occasions, an InstallShield install can fail due to remnants in the TEMP folder of a previously aborted install. You can avoid this problem by clearing the contents of the TEMP folder.

### License Servers

The license server must be started unless you are using an Evaluation license or are using another network node as a floating license server. When the license server is properly started, the lmgrd and nilm processes should appear in the process list of the Windows task manager. You can use the MATRIXx License Server applet in the Windows Control Panel to start or stop the license server or to check its status. You can also check the contents of the license server diagnostic log file, `installation_directory\NILM\debug.log`, to see if the license server is running correctly. If the license server is running and you wish to use a different copy of the license.dat file, you should stop the license server first, copy the new license.dat file and then restart the license server.

If you try to perform one of the following licensing tasks and receive an error message, you may be able to correct it by identifying the cause as described in Table 4-1.
The following summarizes the items to consider when performing a complete uninstall of MATRIXx software:

- All MATRIXx and Altia software should be removed by using the Add/Remove Programs applet in the System Control Panel.
- If you want to uninstall the optional Altia Design software and it is installed under the MATRIXx installation directory, then NI recommends that you uninstall it before removing MATRIXx.
- (Windows 2000/NT/XP) If you want to uninstall the MATRIXx License Server, then NI recommends that you uninstall it before removing MATRIXx.
- (Windows NT) If you want to uninstall a server installation of the MATRIXx version 7.x software, you should first remove any file shares associated with the MATRIXx installation directory.

You will need to complete the following steps to completely remove both the license server and the MATRIXx software:

1. Stop and remove the MATRIXx License Server service from your machine complete the following steps:
   a. Select Start»National Instrument»MATRIXx mx_71.1»NI Licence Manager»Imtools.

## Table 4-1. Error Message Definitions

<table>
<thead>
<tr>
<th>Command</th>
<th>Error Message or Problem</th>
<th>Cause or Remedy</th>
</tr>
</thead>
<tbody>
<tr>
<td>lmdiag</td>
<td>lmdiag reports that the hostid is correct, but the license daemon has not been started.</td>
<td>Kill all lmgrd processes started for the license.dat file (they are trying to use the same TCP/IP port) and start a new lmgrd process.</td>
</tr>
<tr>
<td>lmreread -c license_file</td>
<td>You cannot use lmreread to change server node names or port numbers.</td>
<td>You have changed the server name or port number. Kill the old daemon, then restart the license daemon.</td>
</tr>
</tbody>
</table>

### Uninstalling Version 7.x

The following summarizes the items to consider when performing a complete uninstall of MATRIXx software:

- All MATRIXx and Altia software should be removed by using the Add/Remove Programs applet in the System Control Panel.
- If you want to uninstall the optional Altia Design software and it is installed under the MATRIXx installation directory, then NI recommends that you uninstall it before removing MATRIXx.
- (Windows 2000/NT/XP) If you want to uninstall the MATRIXx License Server, then NI recommends that you uninstall it before removing MATRIXx.
- (Windows NT) If you want to uninstall a server installation of the MATRIXx version 7.x software, you should first remove any file shares associated with the MATRIXx installation directory.

You will need to complete the following steps to completely remove both the license server and the MATRIXx software:

1. Stop and remove the MATRIXx License Server service from your machine complete the following steps:
   a. Select Start»National Instrument»MATRIXx mx_71.1»NI Licence Manager»Imtools.
b. In the **Start/Stop/Reread** tab click **Stop Server**. If a failure is reported, the server may already be stopped.

c. On the **Config Services** tab click **Remove Service**.

2. To remove the MATRIXx License Server and MATRIXx version 7.x software complete the following steps:

   a. Use **Control Panel»Add/Remove Programs** to remove the MATRIXx License Server.

   b. Use **Control Panel»Add/Remove Programs** to remove the MATRIXx version 7.x software.
FLEXlm Licensing Tools

This chapter describes the FLEXlm utilities. This includes explaining how to troubleshoot common license manager problems and describes messages from the daemon log file. For additional licensing documentation, refer to the FLEXlm End User Manual from Macrovision Corporation on the MATRIXx documentation CD.

FLEXlm Utilities

MATRIXx Product Family version 7.x uses FLEXlm for its license server. FLEXlm provides the following utilities to help manage the licensing activities on the network:

- **lmstat**: Helps you monitor the status of all network licensing activities.
- **lmdiag**: Lets you diagnose problems when you cannot check out a license.
- **lmgrd**: Starts the license daemon.
- **lmhostid**: Reports the host ID of a system.
- **lmreread**: Causes the license daemon to reread the license file and start any new vendor daemons.
- **lmver**: Reports the FLEXlm version of a library or a binary.
- **lmborrow**: Supports license borrowing.
- **lmutil**: FLEXlm license server management and administration.
- **lmtools**: Graphical user interface for FLEXlm utilities.

**lmgrd**

lmgrd is the main daemon program for FLEXlm. When you invoke lmgrd, it looks for the license file. The license file contains information about vendors and features.
Syntax is:
```
lmgrd -app [ -c license_file ] [ -t timeout ][ -s interval ]
[ -b ] [ -l logfile ]
```
where:

- **-app**  | Is required for Windows systems.  
- **-c license_file**  | Uses the specified license file.  
- **-t timeout**  | Sets a timeout interval, in seconds, during which redundant daemons must complete their connections to each other. The default value is 10 seconds. A larger value may be desirable if the daemons are being run on busy systems or a heavily loaded network.  
- **-s interval**  | Specifies the logfile timestamp interval, in minutes. The default is 360 minutes.  
- **-l logfile**  | Specifies the pathname to the log file. If this option is not specified, the log will be sent to standard output.  
- **-v**  | Prints the lmgrd version number.

### lmstat

The lmstat utility helps you monitor the status of all network licensing activities, including:

- Which daemons are running  
- Users of individual features  
- Users of features served by a specific daemon

Syntax is:
```
lmstat [-a] [-S [DAEMON]] [-f [feature]]
[-s [server_name]] [-t value] [-c license_file] [-A]
[-l [regular expression]]
```
where:

- **-a**  | Displays everything.  
- **-A**  | Lists all active licenses.
lmreread

The lmreread utility causes the license daemon to reread the license file and start any new vendor daemons that have been added. Additionally, all pre-existing daemons will be signaled to reread the license file for changes in feature licensing information. Syntax is:

```bash
lmreread [-c license_file]
```

Note: If you use the -c option, the license file specified will be read by lmreread, not by lmgrd; lmgrd rereads the file it read originally. Also, lmreread cannot be used to change server node names or port numbers. Vendor daemons will not reread their option files as a result of lmreread.

lmhostid

The lmhostid utility reports the host ID of a system. Syntax is:

```bash
lmhostid [ether | long]
```

The output of this command appears as follows:

```bash
lmhostid - Copyright (c) 1989, 199x Highland Software, Inc. The FLEXlm host ID of this machine is "69021c89"
```

The ether option causes lmhostid to print the Ethernet address on Hewlett-Packard (HP) systems. On HP systems the long option prints the value of the HP ID module. These options are only available in FLEXlm v2.21 or later. The default is long for FLEXlm v2.21 or earlier, and ether for FLEXlm v2.4 or later.
lmdiag

lmdiag allows you to diagnose problems when you cannot check out a license.

Usage is:
```
lmdiag [-c license_file] [-n] [feature]
```

where `-c license_file path` to file to diagnose. `-n` run in noninteractive mode; lmdiag will not prompt for any input in this mode. In this mode, extended connection diagnostics are not available. Feature diagnose this feature only.

If no feature is specified, lmdiag will operate on all features in the license file(s) in your path. lmdiag will first print information about the license, then attempt to check out each license. If the checkout succeeds, lmdiag will indicate this. If the checkout fails, lmdiag will give you the reason for the failure. If the checkout fails because lmdiag cannot connect to the license server, then you have the option of running “extended connection diagnostics.”

These extended diagnostics attempt to connect to each port on the license server node, and can detect if the port number in the license file is incorrect. lmdiag will indicate each port number that is listening, and if it is an lmdiag process, lmdiag will indicate this as well. If lmdiag finds the vendor daemon for the feature being tested, then it will indicate the correct port number for the license file to correct the problem.

lmver

lmver reports the FLEXlm version of a library in binary. Usage is:
```
lmver [filename]
```

where `filename` can be nilm.exe or lmgrd.exe.

lmborrow

lmborrow supports borrowing of licenses that contain the BORROW attribute. It must be run on the machine where licenses are borrowed. It is used to perform the following:

- Initiating borrowing by setting the borrow period
- Clearing the borrow period
Determining borrow status
Returning a borrowed license early

Initiating Borrowing

To initiate borrowing, the user sets the borrow period by running `lmborrow` from the command line or through LMTOOLS:

```
lmborrow {vendor | all} enddate [time]
```

where:

- **vendor**
  - The vendor daemon name that serves the licenses to be borrowed, or all specifies all vendor daemons in that license server.

- **enddate [time]**
  - Date the license is to be returned in `dd-mm-yyyy` format. Time is optional and is specified in 24-hour format (hh:mm) in the FLEXlm-licensed application’s local time. If time is unspecified, the checkout lasts until the end of the given end date.

For example:

```
lmborrow sampled 20-aug-2001 13:00
```

(Windows) This has the effect of setting `LM_BORROW` with the borrow period in either registry.

To borrow licenses for the desired vendor, **on the same day and the same machine** that the user runs `lmborrow`, run the application(s) to check out the license(s). If you run the application(s) more than once that day, no duplicate licenses are borrowed. No licenses are borrowed if the application is run on a day different than the date borrowing is initiated.

In addition to the `lmborrow` utility, there are other ways to initiate borrowing:

- Using the borrowing interface in application, if provided in the application.
- Setting the `LM_BORROW` environment variable directly.
Clearing the Borrowed License Setting

To clear the LM_BORROW setting in the registry issue the command:

```
lmborrow -clear
```

Clearing the LM_BORROW setting stops licenses from being borrowed until borrowing is initiated again. A user might run `lmborrow -clear` after he has borrowed licenses for features that are used offline if—before disconnecting from the network—he wants to run an application that checks out additional features, served by vendor, that are not meant to be borrowed. Clearing LM_BORROW does not change the status for already-borrowed licenses.

Determining Borrowed License Status

To print information about borrowed features, issue the following command on the machine from which they are borrowed:

```
lmborrow -status
```

The borrowing system does not have to be connected to the network to determine the status.

Returning a Borrowed License Early

To return a borrowed license early, first reconnect the borrowing system back to the network and then, from the same machine that initiated the borrowing, issue the command:

```
lmborrow -return [-c license_file_list] [-c display] feature
```

where:

- `-c license_file_list` Use the specified license file(s). In some configurations, the license file needs to be specified in order to return the license file early.

- `-d display` Used to specify the display from which the borrow was initiated. Required if you current display is different than what was used to initiate the borrow. On Windows, it is the system name or, in the case of a terminal server enironment, the terminal server client name.
Returning the license early has the effect of clearing the LM_BORROW setting for the vendor daemon that serves the returned license.

If the borrowing system is not placed back on the network before attempting the early return, the license is not returned and LM_BORROW is kept intact. Additionally, an error message is issued to the end user with notification that the system needs to be connected to the network.

**lmutil**

The following are valid arguments for most lmutil utilities:

- `-c license_file_path` Most lmutil utilities need to know the path to the license file. This is specified with a `-c license_file_path` argument, or by setting the LM_LICENSE_FILE environment variable. Otherwise, the default location is used. The utilities also honor all VENDOR_LICENSE_FILE environment variables. Some utilities take more than one license file path in a license-file list separated by semi-colons. Pathnames which include spaces have to be enclosed in double quotes.

- `-v` Prints the FLEXlm version of the utility.

- `-verbose` Prints the description for all errors found. The output from the utilities may be harder to read with this option, but is useful for diagnostics. (v6.0+ only)

**lmtools**

For the 32-bit Windows platforms, a graphical user interface to the license manager tools is provided called LMTOOLS. Always use the newest version of LMTOOLS as possible; it is available for download from www.macrovision.com.
Some of the functions LMTOOLS performs include:

- Starting, stopping, and configuring FLEXlm license servers
- Getting system information, including hostids
- Getting server status

LMTOOLS has two modes in which to configure a license server:

- Configuration using a license file
- Configuration using services

### Configuration Using License File

Operations are performed on a particular license file. The file can be either local or remote. In this mode, you cannot start the lmgrd process, but you can do everything else. To configure this mode, perform the following:

1. Invoke LMTOOLS.
2. Click the **Configuration using License File** radio button.
3. Enter one or more the license file names or `port@host` specifications.

### Configuration Using Services

Operations are performed on a service, which allows starting lmgrd processes local to the system on which LMTOOLS is running. On 2000/NT/XP, you configure a Windows Service. On Windows 95/98, you configure a FLEXlm service that behaves similarly to a Windows service.

### Resolving Problems

This section offers some general debugging tips, and discusses information you should gather before contacting support. The **Troubleshooting License Manager Problems** section lists common license manager problems users have encountered before.

### General Debugging Tips

The following are tips for debugging:

- Examine the `%MTXHOME%\NILM\debug.log` file.
- If you cannot check out a feature, run:
  ```
  %MTXHOME%\NILM\lmdiag -c %MTXHOME%\NILM\license.dat
  ```
Chapter 5  FLEXlm Licensing Tools

- If the license daemon appears to have started correctly (which you should be able to determine from the \texttt{ni.log} file), try running \texttt{lmstat} to see if that program has the same problem as your application.

\texttt{lmstat -a -c \%MTXHOME\%NILM\license.dat}

**Support Issues**

When you make a support call, please be prepared to answer the following questions:

- What kind of machine is your license daemon running on? What version of the operating system is the application running on?
- What version of FLEXlm does the program use? Use the following command on your nilm vendor daemon and application:

\texttt{%MTXHOME\%NILM\lmver %MTXHOME\%NILM\nilm.exe}

- What error or warning messages appear in the log file? Did the daemon start correctly? Look for a message such as:

\texttt{server xyz started for: feature1 feature2.}

- What is the output from running \texttt{lmstat -a}?
- Are you running other products which are also licensed by FLEXlm? National Instruments does not support combined license files.
Troubleshooting License Manager Problems

This section lists areas of FLEXlm administration that have given customers difficulty in the past. Categories are Host ID Problems, Connection Problems, and Other Client Problems.

Host ID Problems

**symptom** When I run the license manager on my machine, it tells me it is the wrong host ID.

**cause** The vendor daemon checks the host ID listed on the server line in the license file; if it does not match the host ID of the machine it is running on, this message will be printed.

Possible causes include:

1. You are trying to run the license daemon on a different machine from the machine the file was made for.
2. The host ID of the machine you are running on changed (for example, the HP ID module was moved, or the CPU board was replaced).
3. The host ID in the license file was modified.

**solution** Verify that the host ID of the machine where the vendor daemon (or node-locked client program) is being run matches the host ID specified in the license file (on the server line for the vendor, or on the feature line for a node-locked client). You can run the lmhostid program to see what FLEXlm thinks the host ID is. You cannot modify the host ID in the license file. If the host ID of your server machine changes, you will have to get a new license file from your software vendor.
Connection Problems

**symptom** The application program (or lmstat) cannot connect to the server to check out a license.

**cause** The FLEXlm routines in the application are unable to make a TCP connection to the server and port specified in the license file. Possible reasons for this are:

1. The wrong license file is being referenced by the application program.
2. The server machine specified in the license file is down.
3. The vendor daemon specified in the license file is not running.
4. The hostname in the license file is not recognized by the system.
5. The network between the client machine and the server machine is down.
6. TCP is not running on your machine.

**solution** Verify that the application is using the proper license file. Verify that the specified server machine is up and reachable by executing another command that uses TCP, such as rsh or rlogin, from the client to the server. Verify that the vendor daemon is running (you can use the ps command on the server to look for it). Examine the license log file to see if any problems are reported, particularly messages indicating that the vendor daemon has quit. Run lmstat -a from the server machine to verify that the vendor daemon is alive. Run lmstat -a from the client machine to verify the connection from client to vendor daemon across the network. Try using telnet hostname portnum where hostname and portnum are the same as on the server line in your license file.
Other Client Problems

**symptom** When I run my application program (or vendor daemon), I get the error **bad code**.

**cause** Possible causes for this are:
1. The license file was modified (either the host ID on a *server* line or anything on the *feature* line was changed).
2. The vendor used the wrong version of his license creation program to generate your license file (or there is a bug in that process).

**solution** You cannot modify the license file. If you need to change something in your license file, you must get a new license from National Instruments.

**symptom** When the second user tries to check out a license, the vendor daemon prints an error concerning **Parameter mismatch** in the log file and refuses the license.

**cause** The most likely cause of this problem is that you are simultaneously trying to run two different versions of the application program, and the software vendor has not specifically set up the new version for this kind of compatibility. Check the license server log file for a **comm version mismatch** warning message; this indicates that someone is running a V1.5 client with a V2.1 or later license server.

**solution** Run only the new version of the application (or only the old version).

Other Server Problems

**symptom** When I start lmgrd, it says **Retrying socket bind** (address in use: port xxxx).

**cause** The license server listens on the port xxxx that has already been used by another server program. 99.44% of the time, if it’s in use, it’s because lmgrd from NI or another vendor is already running on the port—or was recently killed, and the port isn’t freed yet.
solution  In the license.dat file NI has put 27000 at the end of the SERVER line as the port number. You can remove it to let lmgrd scan for a free port from 27000 to 27009. You can also specify a port number selected by yourself for other concerns like farewell.

⚠️ Caution  The portscan feature of lmgrd is only available for FLEXlm v6+ licenses. You cannot drop the port numbers when configuring redundant servers.

symptom  When I start up lmgrd, it says exec1 failed on my vendor daemon.

cause  lmgrd uses exec1 to start each vendor daemon running. If there is a problem starting the vendor daemon, this message is output to the log file. This error is typically caused by one of the following:

1. There is no executable at the location referred to by the license file (and printed out in the log file).
2. The executable does not have the proper protection to be run (the file does not have the x bit set, or one of the directories in the path is not readable).
3. There was an error building the executable, and it cannot be run.
4. The executable is for a different machine architecture.

solution  Verify that the path to the vendor daemon is absolute, and that it points to the executable program itself, not the containing directory (for FLEXlm v1.5). Ensure that the file exists by doing an ls -l of the vendor daemon filename(s) specified in the log file. Make sure you do this as the same user that started lmgrd. Verify that the file is executable. Run the vendor daemon directly from the command line. If the vendor daemon is properly linked, it will tell you that it must be run from lmgrd; if it crashes or fails to execute, then it is not properly linked.

symptom  The license server keeps reporting lost lock errors in the log file and exiting.

cause  The lockfile is being removed by someone else. There could be another daemon running, or the system administrator (or a script) could have deleted the file.
solution  Check to see if there is more than one copy of the daemon running. Check for more than one lmgrd running as well, since it will restart your vendor daemon when it is killed. If more than one lmgrd is running, kill them all, then kill any remaining vendor daemons and start one fresh copy of lmgrd. Check to see whether a shell script is running that cleans out tmp. If so, try modifying it so that it does not delete zero length files.

Daemon Log File

Daemons generate log files with DAEMON NAME messages where:

**DAEMON NAME** Either license daemon or the string from the DAEMON line that describes your daemon. In the case where a single copy of the daemon cannot handle all of the requested licenses, an optional underscore followed by a number indicates that this message comes from a forked daemon.

**message** The text of the message.

The log file, available as %MTXHOME%\NILM\debug.log, can be used to:

- Inform users when they need to purchase additional application software licenses.
- Diagnose configuration problems.
- Diagnose daemon software errors.

Informational Messages

These messages are only informational and do not necessarily indicate an error or a problem.

<p>| Connected to node. | This daemon is connected to its peer on node node. |
| CONNECTED, master is name. | The license daemons log this message when a quorum is up and everyone has selected a master. |
| DENIED: N feature to user (N licenses) | user was denied access to N licenses of feature. |
| EXITING DUE TO SIGNAL nnn. EXITING with code nnn. | All daemons list the reason that the daemon has exited. |
| EXPIRED: feature. | feature has passed its expiration date. |</p>
<table>
<thead>
<tr>
<th>Event Description</th>
<th>Explanation</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>IN: feature by user</strong> <em>(N licenses).</em></td>
<td>user has checked back in N licenses of feature.</td>
</tr>
<tr>
<td><strong>License Manager server started.</strong></td>
<td>The license daemon was started.</td>
</tr>
<tr>
<td><strong>Lost connection to host.</strong></td>
<td>A daemon can no longer communicate with its peer on node <em>host</em>, which can cause the clients to have to reconnect, or cause the number of daemons to go below the minimum number, in which case clients may start exiting. If the license daemons lose the connection to the master, they will kill all the vendor daemons; vendor daemons will shut themselves down.</td>
</tr>
<tr>
<td><strong>Lost quorum.</strong></td>
<td>The daemon lost quorum, so it will only process connection requests from other daemons.</td>
</tr>
<tr>
<td><strong>MULTIPLE xxx servers running. Please kill, and restart license daemon.</strong></td>
<td>The license daemon has detected that multiple copies of vendor daemon <em>xxx</em> are running. The user should kill all <em>xxx</em> daemon processes and restart the license daemon.</td>
</tr>
<tr>
<td><strong>OUT: feature by user (N licenses).</strong></td>
<td>user has checked out N licenses of feature</td>
</tr>
<tr>
<td><strong>RESERVE feature for HOST name.</strong> <strong>RESERVE feature for USER name.</strong></td>
<td>A license of <em>feature</em> is reserved for either user <em>name</em> or host <em>name</em>.</td>
</tr>
<tr>
<td><strong>REStarted xxx (internet port nnn)</strong></td>
<td>Vendor daemon <em>xxx</em> was restarted at internet port <em>nnn</em>.</td>
</tr>
<tr>
<td><strong>Retrying socket bind (address in use).</strong></td>
<td>The license servers try to bind their sockets for approximately 6 minutes if they detect “address in use” errors.</td>
</tr>
<tr>
<td><strong>Selected (EXISTING) master node.</strong></td>
<td>This license daemon has selected an existing master (node) as the master.</td>
</tr>
<tr>
<td><strong>SERVER shutdown requested.</strong></td>
<td>A daemon was requested to shut down through a user-generated kill command.</td>
</tr>
<tr>
<td><strong>[NEW] Server started for: feature-list</strong></td>
<td>A (possibly new) server was started for the features listed.</td>
</tr>
<tr>
<td><strong>Shutting down xxx.</strong></td>
<td>The license daemon is shutting down the vendor daemon <em>xxx</em>.</td>
</tr>
<tr>
<td><strong>SIGCHLD received. Killing child servers.</strong></td>
<td>A vendor daemon logs this message when a shutdown was requested by the license daemon.</td>
</tr>
</tbody>
</table>
### Configuration Problem Messages

<table>
<thead>
<tr>
<th>Message</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Started name.</td>
<td>The license daemon logs this message whenever it starts a new vendor daemon.</td>
</tr>
<tr>
<td>Trying connection to node.</td>
<td>The daemon is attempting a connection to node.</td>
</tr>
<tr>
<td>hostname: Not a valid server host, exiting</td>
<td>This daemon was run on an invalid hostname.</td>
</tr>
<tr>
<td>hostname: Wrong hostid, exiting</td>
<td>The host ID is wrong for hostname.</td>
</tr>
<tr>
<td>BAD CODE for feature-name</td>
<td>The specified feature name has a bad encryption code.</td>
</tr>
<tr>
<td>CANNOT OPEN options file file</td>
<td>The options file specified in the license file could not be opened.</td>
</tr>
<tr>
<td>license daemon: lost all connections</td>
<td>This message is logged when all the connections to a daemon are lost, which often indicates a network problem.</td>
</tr>
<tr>
<td>lost lock, exiting</td>
<td>Error closing lock file.</td>
</tr>
<tr>
<td>Unable to re-open lock file</td>
<td>The vendor daemon has a problem with its lock file, usually because of an attempt to run more than one copy of the daemon on a single node. Locate the other daemon that is running via a <code>ps</code> command, and kill it with <code>kill -9</code>.</td>
</tr>
<tr>
<td>NO DAEMON line for daemon</td>
<td>The license file does not contain a <code>DAEMON</code> line for daemon.</td>
</tr>
<tr>
<td>No license service found</td>
<td>The TCP <code>license</code> service did not exist.</td>
</tr>
<tr>
<td>No license data for feat, feature unsupported</td>
<td>There is no feature line for <code>feat</code> in the license file.</td>
</tr>
<tr>
<td>No features to serve!</td>
<td>A vendor daemon found no features to serve. This could be caused by bad data in the license file.</td>
</tr>
<tr>
<td>UNSUPPORTED FEATURE request: feature by user</td>
<td>The user has requested a feature that this vendor daemon does not support. This can happen for a number of reasons: the license file is bad, the feature has expired, or the daemon is accessing the wrong license file.</td>
</tr>
<tr>
<td>Unknown host: hostname</td>
<td>The hostname specified on a <code>SERVER</code> line in the license file does not exist in the network database.</td>
</tr>
</tbody>
</table>
Daemon Software Error Messages

<table>
<thead>
<tr>
<th>Error Message</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>NO DAEMON lines, exiting</td>
<td>The license daemon logs this message if there are no DAEMON lines in the license file. Since there are no vendor daemons to start, there is nothing to do.</td>
</tr>
<tr>
<td>NO DAEMON line for name</td>
<td>A vendor daemon logs this error if it cannot find its own DAEMON name in the license file.</td>
</tr>
<tr>
<td>select: message</td>
<td>An error in a select system call was detected.</td>
</tr>
<tr>
<td>Server exiting</td>
<td>The server is exiting. This is normally due to an error.</td>
</tr>
</tbody>
</table>
Technical Support and Professional Services

Visit the following sections of the National Instruments Web site at ni.com for technical support and professional services:

- **Support**—Online technical support resources at ni.com/support include the following:
  - **Self-Help Resources**—For immediate answers and solutions, visit the award-winning National Instruments Web site for software drivers and updates, a searchable KnowledgeBase, product manuals, step-by-step troubleshooting wizards, thousands of example programs, tutorials, application notes, instrument drivers, and so on.
  - **Free Technical Support**—All registered users receive free Basic Service, which includes access to hundreds of Application Engineers worldwide in the NI Developer Exchange at ni.com/exchange. National Instruments Application Engineers make sure every question receives an answer.

- **Training and Certification**—Visit ni.com/training for self-paced training, eLearning virtual classrooms, interactive CDs, and Certification program information. You also can register for instructor-led, hands-on courses at locations around the world.

- **System Integration**—If you have time constraints, limited in-house technical resources, or other project challenges, NI Alliance Program members can help. To learn more, call your local NI office or visit ni.com/alliance.

If you searched ni.com and could not find the answers you need, contact your local office or NI corporate headquarters. Phone numbers for our worldwide offices are listed at the front of this manual. You also can visit the Worldwide Offices section of ni.com/niglobal to access the branch office Web sites, which provide up-to-date contact information, support phone numbers, email addresses, and current events.